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1.0 General Introduction 
 

This document provides an introduction to MTO workspace configuration for Bentley 

OpenRoads Designer CONNECT Edition (ORD). The configuration and customization 

have been updated to and tested with OpenRoads Designer CONNECT Edition 2021 

Release 2 (10.10.21.04).  

 

The MTO customized workspace for ORD is available for MTO and Service Provider 

staff working on MTO highway projects. MTO ORD workspace files and resources are 

provided “As Available” without any warranty, and subject to change with future updates 

and enhancements. 

 

 

1.1  OpenRoads Designer CONNECT Edition 
 

ORD CONNECT Edition is a new application that replaces the capabilities of all 

applications in the InRoads, GEOPAK, MX, PowerCivil for Civil, and GeoMacao 

product lines in a single offering.  

 

Upgrade to OpenRoads Designer was a huge leap. Although most of the basic concepts 

of the program had been retained, the underlying data structures, the workspace, and the 

workflow had been dramatically changed. OpenRoads Designer is built on OpenRoads 

modeling technology and provides significant new design modeling, analytical modeling 

and project collaboration capabilities.  

 

1.2  User Interface 
 

ORD’s user interface has been redesigned. It now features ribbons, context menus, heads-

up display, graphical and dynamic edits. ORD uses the Startup screen to select or create 

the WorkSpaces and WorkSets, open existing files, and create new files.  
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The graphical user interface of ORD is now based on ribbon design. Ribbons are 

organized by workflow. Each workflow consists of multiple tabs, which are organized by 

tasks.  

 

The workflows are activated from the Quick Access Toolbar in the upper left corner. 

 

 
 

 
 

Select a workflow will load a series of tabs containing relevant tools in groups at the top 

of the ribbon. 

 

The ribbon menu of the OpenRoads Modeling workflow is organized into simliar 

categores called Ribbon Tabs as the InRoads Explorer menus.  

 

 
 

 

The ribbon tabs included in the OpenRoads Modeling workflow are: 

 

Home Attributes, primary (commonly used) tools, element selection 

tools, model analysis and reporting, and import/export tools. 

Terrain Element selection, terrain modeling, editing, and analysis tools. 

Geometry Element selection, horizontal and vertical geometry tools, and 

general tools (standards, civil accudraw, etc.). 

Site Element selection and site optimization tools. 

Corridors Element selection, template, corridor, and superelevation 

modeling tools. 
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Model Detailing Element selection, civil cells, and 3D tools (linear template, 

surface templates, etc.). 

Drawing Production Element selection, clip volume, saved views, tables, notes, 

text, labels, annotations, and named boundaries(plans 

production) tools. 

Drawing Commonly used MicroStation drawing tools.  

Utilities Geographic, item type tools.  

Collaborate Collaboration, clash detection and markup tools.  

View Commonly used view control tools. 

 

 

1.3  Backstage Functionality 
 

The File tab opens the backstage view where you can set user preferences and change 

design file-specific settings, manage documents, import and export files, access help, and 

so on.  

 

 
 

The seed and library files in MTO workspace are set to confirm MTO AutoCAD 

standards. The configuration files contain MTO workspace and workset configuration 

variables. Caution must be exercised when change the settings for these files. 

 

1.4  File Types 
 

In ORD, all civil data is stored within the DGN file, minimizing or eliminating the use of 

external files. Surfaces, geometry, corridors, etc. are all stored in DGN files.  
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The legacy file types such as .dtm, .alg, .ird, etc. used in InRoads/Power InRoads can be 

imported into ORD. 

 

The InRoads XIN file which contains feature styles, symbologies, annotations, 

preferences, and other settings is replaced with the MicroStation dgn library file (.dgnlib). 

 

 

1.5  WorkSpace Configuration 
 

ORD uses MicroStation as its CAD platform. The WorkSpace has been changed and 

enhanced. The ORD workspace configuration contains resources, configuration files, 

configuration variables, Workspaces, and WorkSets. This multi-level configuration file 

structure provides a flexible way to configure the work environment. 

 

A WorkSpace is a container for grouping WorkSets, standard files and associated 

configuration files that are used for specific projects or disciplines. 

 

Under WorkSpace, there are WorkSets. A WorkSet is a container for grouping project 

files, associated data, and project specific resources and standards that will supplement 

the workspace standards. 

 

 

1.6  Feature Definition  
 

OpenRoads Designer is a feature based design environment. OpenRoads Designer uses 

feature in design to represent a real world thing that can be seen or located. Feature 

definition is used to define options when creating features. Feature definitions take the 

place of Styles in SS2 to control how a feature is to be displayed, annotated, and 

computed.  

 

There are different types of feature definitions in OpenRoads Designer and each has 

different properties. Below is a list of feature definition types in the roadway modeling: 

 

- Alignment 

- Terrain 

- Corridor 

- Superelevation 

- Linear Template 

- Surface Template 

- Linear 

- Point 

- Mesh 

- Trace Slope 

- Aquaplaning 

- Sight Visibility 
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2.0 OpenRoads Designer Workspace Configuration 
 

MTO workspace for OpenRoads Designer contains WorkSets, resources that are used in 

designs, standards files, and associated configuration files. It was developed based on 

MTO AutoCAD standards and Power InRoads V8i (SS2) standards. Most of the SS2 

styles are brought into ORD, however, many new feature definitions have been created to 

use the feature and rule based new design environment.  

 

The workspace can be further customized to fit into organization’s workspace or 

modified to meet specific project requirements. 

 

Download MTO’s OpenRoads Designer workspace from the following internet address: 

https://www.xfer.mto.gov.on.ca/ 

 

The default location for the workspace is C:\MTO ORD Standards. Modify the 

configuration file if you have a different location.  

 

 

2.1  Configuration Files 
 

OpenRoads Designer uses the configuration files and variables to set up the work 

environment. Configuration file WorkSpaceSetup.cfg contains variable to specify the 

workspace location. It is located in the following folder:  

 

C:\ProgramData\Bentley\OpenRoads Designer CE 10.10\Configuration\ 

 

To use MTO ORD configuration from the default location C:\MTO ORD Standards, 

copy the WorkSpaceSetup.cfg from the downloaded zip file to above mentioned location. 

 

To use the standards from a different location, modify the WorkSpaceSetup.cfg  file to 

point to the user selected location. 

 

Open the configuration file with Notepad or other text editor. Modify the following 

variables with the appropriate path. 

 

MY_CIVIL_ORGANIZATION_ROOT 

MY_WORKSPACES_LOCATION  

 

https://www.xfer.mto.gov.on.ca/
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MTO ORD WorkSpace is customized at the organizational level and MTO ORD standard 

files are located in the following folder: 

 

 ……\Organization-Civil\MTO\ 
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In this folder, there are series folders as shown below. Some of them also contain 

subfolders.  

 

 
 

 

The default workset loaction for MTO workspace is located at C:\MTO ORD 

Standards\WorkSpaces\MTO\ (see WorkSpaceSetup.cfg). 

 

The default workspace configuration file MTO.cfg located in the folder C:\MTO ORD 

Standards\WorkSpaces\ will define which ORD standard (the 

“CIVIL_ORGNIZATION_NAME”) to be loaded for current workspace. 
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To Find the Location of your Active WorkSpace and WorkSets, 

 

Select File > Settings > Configuration > About Configuration.   

 

The About Configuration window opens, displaying information about the active 

WorkSpace and its components. 
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2.2  WorkSpace and WorkSet 
 

The MTO workspace is accessed from the OpenRoads Designer menu as shown below: 
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After selecting the WorkSpace, click on the Create a WorkSet button to create a new 

WorkSet.   

 

 
 

 

 



 

 
 OpenRoads Designer User Guide – Version 1.0                                                                  Page 11 

 
 

Once the WorkSet has been created, it will appear on the WorkSet list. 

 

If there are worksets in the current workspace, select a Workset from the list or use the 

Create WorkSet command on the bottom of the WorkSet list to create a new Workset. 
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2.3 Project Folder  
 

By default, the project folder (the workset) has a simple file folder structure, one for 

design files, one for design outputs, and one for the project specific standards.  

 

 
 

Additional folders may be created to organize files in disciplines or categories such as 

survey, structure, drainage, terrain, geometry, superelevation, corridors, reports, sheets, 

etc. especially when work on large, complex projects.  

 

 

2.4 Seed Files  
 

In order to use the full functionality of OpenRoads Designer, DGN design files are 

required. Seed files are templates used to create DGN files. They contain settings and 

configurations. According to MTO CAD standards, two seed files MTO_Seed2D 

Design.dgn and MTO_Seed3D Design.dgn are provided in the following folder: 

 

 ……\Organization-Civil\MTO\Seed\ 

 

These seed files are set to use the standard AutoCAD color table. This is in consistence 

with MTO CAD standards and provides the consistency in graphic display, file sharing 

and plotting. 

 

Generally, the 3D seed file is only needed for survey and terrain workflows. 

 

MTO uses metric units for highway design. The working units are defined in the seed 

files as shown below.  
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MTO custom line styles are defined from MTO CAD standards (IESCAD). They are 

created at a scale of 1:1 for drafting at a scale of 1:1000 (1 drawing unit = 1m).  

 

The Line Style Scale settings are shown as below.   
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2.5  Levels  
 

The following groups of levels based on MTO AutoCAD Standards (IESCAD) are 

included in ORD library: 

Planning and Design (PD - *) 

Surveys and Plans (SP - *) 

Photogrammetry (PH - *) 

Structural Design (ST - *) 

Traffic (TR - *) 

Additional levels are defined for element templates, feature symbologies, feature 

definitions, and ORD specific features or functions. 

 

 

2.6  Fonts & Text Styles 
 

The text styles, text favorites are defined in MTO_Text Favorites_Text 

Styles_Dimension Styles.dgnlib in the folder: 

 

 ……\Organization-Civil\MTO\Dgnlib\Feature Definitions\ 

 

All text styles in MTO workspace use standard true type font Arial. 

 

Standard text sizes (heights) have been defined. The following sizes are used: 0.0001, 

0.0005, 0.001, 0.002, 0.0025, 0.003, 0.004 & 0.005.  
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3.0 Feature Definition DGN Library 
 

Feature Definitions, Feature Symbologies, Annotation Definitions & Groups, levels and 

Element Templates are provided in the dgn library 

MTO_Features_Annotations_Levels_ElemTemp.dgnlib in the folder: 

 

 ……\Organization-Civil\MTO\Dgnlib\Feature Definitions\ 

 

 

3.1  Feature Definitions 
 

Feature Definitions are used to control symbology, annotation, and various other 

properties that are applied to the geometric elements. A Feature Definition defines what 

an item is and links to Feature Symbology to define how the item is displayed. 

 

Each feature definition type has different properties but has three in common: Name, 

Description and Name Seed. 

 

 
 

MTO ORD feature definitions are based on MTO AutoCAD Standards Guide and MTO 

InRoads Preference and Standards (SS2). The feature definitions are defined with specific 

names and organized into categories according to the element type. Some categories are 

further grouped into subcategories.  

 

 
 

Feature definitions corresponding to the SS2 styles that are named with the IESCAD 

layer names in Planning and Design, Photogrammetry, Surveys and Plans sections, and 

SS2 specific styles are defined and organized under subcategories with a prefix SS2 in 

the category name. These feature definitions can be used to help to import SS2 projects. 
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3.2  Feature Symbologies 
 

Feature Symbologies are used to define how the items are displayed. There are four 

categories are supported including Linear, Point, Profile and Surface with subcategories 

similar to the Feature Definitions. Each of these categories has different parameters.  

 

 
 

Feature Symbologies refer to Element Templates and Annotation Group when required 

for detailed display setting.  
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Both Feature Definitions and Feature Symbologies are accessed through the OpenRoads 

Standards tab on Explorer dialog. 

 

 

3.3  Element Templates 
 

Element Templates define properties of elements. An element template has a set of 

properties (level, color, line style, line weight, text style, material etc.) that can be 

preconfigured for element placement or applied to existing elements. ORD Element 

Templates are used to set up the symbologies, define detailed display settings for both 

MicroStation elements and civil features. The Element Templates can be accessed 

through Home > Attributes: 
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4.0 Template Library 
 

MTO standard template library MTO_STD_Templates.itl is located in the following 

folder: 

 

 ……\Organization-Civil\MTO\Template Library\ 

 

This library contains typical section templates, linear templates, surface templates, 

components and end conditions with predefined point names that are associated with 

MTO OpenRoads Designer standard feature definitions. It can be used to facilitate the 

creation of new components/templates on any project library. 

 

 
 

 

4.1  Point Name List 
 

The standard template library contains a predefined point name list where point names 

are assigned feature definitions defined in dgn library: 

 

MTO_Features_Annotations_Levels_ElemTemp.dgnlib 
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Employ the standard Point Name List and supplement as needed before creating project 

templates. Apply prefix, suffix and layer identifier to the point names and keep the points 

linked to predefined feature styles.  

 

 

4.2  Point Naming Convention: 
 

1. The first component will identify which side of the centerline which needs to be 

set up using template options when creating templates.  

2. The second component will indicate the layer/surface. 

3. The third component will be the point feature name. 

 

Example: for point edge of pavement, L_TP-EP, L_TA-EP, and L_TB-EP.  
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Where:  

L      identifies left of centerline.  

TP, TA or TB    identifies the layer and/or surface.  

EP      identifies the point feature name.  

 

4.3  Template Options 
 

The template options have been set to “Apply Affixes” for default preference MTO. The 

affixes are prefixes L_ and R_. The affixes will be applied to point and component names 

when the components are placed or created in the template.  

 

 
 

For more complicated templates, suffixes can also be added to the point names. 

 

 

4.4  Parametric Constraints 
 

Parametric constraints can be used to change one or more labeled constraint values of a 

template while the template is being processed in the corridor modeling. This allows 

designers to use only one template to handle a number of different conditions.  When use 

Parametric Constraints, designers should consider the constraint types and the design 

features to assign descriptive names for the labels. 

 

Typical label names are combinations of abbreviations such as: 

 

Constraint Types: 
  

Width Horizontal Constraint 

Depth/Thickness/Height Vertical Constraint 

Slope/Slp Slope Constraint 
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Design Features:  
 

Rdwy Roadway 

Shld Shoulder 

SW Sidewalk 

Lane Travel Lane 

Blvd Boulevard 

Pavt Pavement 

Drive Driveway 

Curb Curb 

Ditch Ditch 

Median Median 

 

Material/Surface Layer 
 

Asph Asphalt 

Conc Concrete 

GranA Granular A 

GranB Granular B 

Sand Sand 

WC Wearing Course 

BC Binder Course 

Base Base Course 

SG Subgrade 

 

Suffix 
 

Lt Left 

Rt Right 

 

Some Example Labels: 
 

Lt_Shld_Asph_Depth Left Shoulder Asphalt Depth 

Rt_Shld_Slp Right Shoulder Slope 

Rt_Pavt_Width Right Pavement Width 

GranA_Depth Granular A Depth 

 

 

4.5  Feature Definitions  
 

Feature definitions defined in ORD Standards dgn library are to be applied to the points, 

components. 

 

The feature definitions for points can be found under folder: 

 

…… Linear\Template Points\ 
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The feature definitions for components can be found under folder: 

 

…… Mesh\ 
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5.0 Terrain 
 

Terrain model (similar to InRoads surface) is a three-dimensional DGN element defined 

by points, breaklines, voids, holes, contours to model a surface on the earth. Terrain 

model is stored in 3D design (dgn) file similar to InRoads DTM file. 

 

A boundary is used to constrain the external boundary of the terrain model. No triangles 

are created outside the boundary. 

 

 

5.1  Terrain Feature Definitions 
 

The display of a terrain model is controlled by feature definition and its associated feature 

symbology and element template. Both Existing and Proposed terrain features definitions 

are defined in the workspace. 
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5.2  Import Terrain from DTM Files 
 

Existing Terrain Model can be created from the digital terrain model (DTM) provided by 

survey. ORD supports the following file types: 

 

 
 

Create a design file with the 3D seed file. Select From File command from the Terrain 

tab Create group on the OpenRoads Modeling workflow ribbon. 

 

 
 

On the Select Files To Import dialog, browse to the location where the DTM file located. 

Select the file and confirm. The Import Terrain Model(s) dialog will appear. Set the 

Feature Definition to Terrain\Existing\Existing Boundary and set the Import Options 

to Import Terrain Only. 
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Select Import to start the process. Use the Fit View tool on the Import Terrain Model(s) 

dialog or the active view’s quick access toolbar to place the entire terrain model within 

the active view. 
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5.3  Display Terrain (Model) Data 
 

Terrain model contains both Source Features and Calculated Features. Source Features 

include the data used to create the terrain model, such as boundary, points and breaklines. 

Calculated Features are items that are calculated from the data in the terrain model, such 

as triangles, contours, and high/low points.  

 

The display of a terrain model can be controlled by using feature definition or individual 

parameter setting. 
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Terrain Properties 

 

Select Home > Primary > Properties to open the Properties dialog. Use the Element 

Selection tool to select the terrain model to display the properties in the dialog.  

 

Toggle on and off features or change the parameter values on the dialog will change the 

terrain display.   
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Change Feature Definition 

 

Using the feature definition is a quick way to change the display of a terrain model with a 

set of predefined parameters. 



 

 
 OpenRoads Designer User Guide – Version 1.0                                                                  Page 29 

 

 
 

 

Shown below is terrain displayed with Existing Triangles. 

 

 

 
 

Shown below are terrain displayed with Existing Contours and Proposed Contours. 
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Change Individual Setting 

 

Turn on and off the features or change the parameters to control the terrain display. 
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5.4  Modify the Display of Referenced Terrain Model 
 

In OpenRoads Designer common workflow, the terrain models are stored in 3D design 

files and referenced into the design or project 2D files. The referenced terrain model 

allows the override of symbology and element templates to change the display of the 

terrain model without modifying the source file. 

 

Use the Element Selection tool to select the referenced terrain model to open the 

Properties dialog and display the properties in the dialog. Set the Override Symbology 

option to Yes. 

 

 
 

The Calculated Features Display, Source Features Display and the Element Templates 

fields are now accessible, and the display of the terrain model can be changed as in a 3D 

terrain model file. 
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6.0 Geometry 
 

OpenRoads Designer stores all geometric data directly in the dgn file. Civil geometry 

tools are provided for creating, importing and exporting, manipulating, and modifying the 

civil geometry. MicroStation Manipulate tools are disabled for civil elements.   

 

6.1  Import/Export Geometry 
 

OpenRoads Designer provides tools to import geometry from or export to native products 

(InRoads, GEOPAK and MX). The Import Geometry tool is used to import InRoads ALG 

files. 

 

Create a design file with the 2D seed file. Select Import Geometry command from the 

Geometry tab General Tools group on the OpenRoads Modeling workflow ribbon. 

 

 
 

Browse to the location where the ALG file located. Select the file and confirm. On the 

Import Geometry dialog, select the horizontal with or without the vertical alignment(s) to 

import.  
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There are two options to assign the Feature Definitions, Assign Feature Definitions 

from Table and Assign Feature Definition. The table used here is an Excel spreadsheet 

that maps the Style/Symbology values coming from the imported file to feature 

definitions in ORD. The Assign Feature Definition will assign all selected elements to the 

same feature definition selected in the combo boxes. When both options are selected, 

ORD will look for a match in the table first. If no match is found, the combo box 

selection will be used. 

 

When both options are not used, the alignment(s) will be imported as Not Featurized (no 

Feature Definition assigned) Linear Geometry into level Default. Then the feature 

definition can be assigned to each of the imported alignments individually. 

 

 
 

Select each alignment and set the Feature Definition on the Properties dialog. 

 

     
 

Alignment feature definitions have been setup based on MTO CAD Standard (IESCAD) 

for Planning and Design, Surveys and Plans and Photogrammetry alignment as 

shown below.  
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Select or change the feature definition will change the geometry to the level assigned to 

the feature definition.  

 

 
 

 
 

 

6.2  View Horizontal Alignment Annotation 
 

Horizontal alignment annotation includes both curve set annotation and stationing 

annotation. They are defined in annotation groups and attached to the alignment feature 

definitions. 

 

There are different setups for station annotation for new (P&D) and existing (S&P) 

alignment stationing. The following annotation groups are available: 
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Annotation group MTO_Stationing is similar as annotation group 

MTO_Stationing_PD with different offsets from the center line.  

 

Both annotation groups MTO_Stationing_PD and MTO_Stationing_SP are set up with 

Down Station (looking down the alignment).  MTO_UpStation_PD and 

MTO_UpStation_SP are options for Up Station (looking up the alignment). 

 

Annotation with both major and minor stations are provided as annotation groups 

MTO_Stationing_PD w/Minor and MTO_Stationing_SP w/Minor.   

 

 
 

Annotation groups are assigned to the feature definitions for alignment elements through 

feature symbologies. Select Annotation Element command from the Drawing 

Production tab Annotations group on the OpenRoads Modeling workflow ribbon.  
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By default, the annotation group associated to the feature symbology that the alignment is 

assigned to will be used for the annotation. Follow the prompt to select the alignment and 

reset to complete the command with default annotation group. The curve set information, 

major stations, major and minor ticks, PI stations and cardinal stations are displayed 

along the alignment. Use the Annotation Group Override option on the Annotate 

Element dialog to annotate the alignment with different annotation settings. 

 

 
 

Shown below are alignment with feature definition MTO_Alignment_PD and 

annotation group MTO_Stationing_PD. 

 

 
 

Change the feature definition will automatically change the annotation. Shown below are 

alignment with feature definition MTO_Alignment_SP and annotation group 

MTO_Stationing_SP. 
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The feature definition MTO_Alignment_SP with Up Station annotation group 

MTO_UpStation_SP  is shown below. 

 

 
 

Annotation is placed with the Annotation Scale Lock on. Change the scale (Drawing 

Production > Drawing Scales) will change the annotation automatically. 
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6.3  Import profiles 
 

When import profile(s) from native product InRoads ALG files, the horizontal geometry 

which the profile(s) associated with will be imported at the same time if it is not 

presented in the current drawing. The Feature Definitions can be assigned during the 

Import process with one selected feature definition applied to both horizontal and vertical 

geometry or can be assigned individually after the import. 

 

To assign feature definition to vertical geometry, expand the horizontal geometry the 

vertical geometry associated with on Explorer dialog, then select the vertical geometry 

and set the Feature Definition on the Properties dialog. 

    

 
 

Select the profile and set the Feature Definition on the Properties dialog in Feature 

section.  Feature definitions for profile are available in both Alignment and Linear 

folders.  
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6.4  Profile Settings 
 

When working with vertical geometry, the vertical curve parameters need to be set based 

on the project requirements. Default Profile Settings are shown as below: 
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6.5  Profile Model View 
 

To create vertical geometry, a profile model view must be opened with the Open Profile 

Model tool. The view presents a desired feature in profile thus enabling the vertical 

geometry tools to interact with the chosen feature. 

 

Access the Open Profile Model command from the Geometry tab Vertical group on the 

OpenRoads Modeling workflow ribbon. 

 

Geometry > Vertical > Open Profile Model 

 

Select the element wish to work in profile then follow the prompt to select or open a 

view.  

 

 
 

The selected horizontal geometry name is shown in the title bar of the view. 

 

The Profile Model View also provides easy access to the vertical geometry tools. The 

tools can be docked as a toolbox. 
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Each of the vertical tools has a Feature Definition field on its dialog. Feature definitions 

for profile are available in both Alignment and Linear folders.  

 

 
 

The feature definition has name seed (prefix) assigned. Different name can be assigned 

on the dialog.  
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The surface profile (profile from surface) will apply the terrain feature definition. See 

terrain section for available terrain feature definitions. 

 

 
 

 

6.6  View Profile Annotation 
 

The Annotate Element command can be used to annotate vertical geometry in the Profile 

Model. Feature Definitions have been set up to annotate profile elements using Feature 

Symbologies with assigned Annotation Groups. Shown below are available Annotation 

Groups. 
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Select Annotation Element command from the Drawing Production tab Annotations 

group on the OpenRoads Modeling workflow ribbon or from the Profile Model View. 

 

 
 

 
 

By default, Annotation Group associated to the Feature Symbology that the profile 

elements are assigned to will be used for the annotation. The Annotation Group Override 

option is provided on the Annotate Element dialog. 

 

 
 

Select the profile elements and reset or check the All Elements in Model option to 

complete. Annotation is placed with the Annotation Scale Lock on. Change the scale 

(Drawing Production > Drawing Scales) will change the annotation automatically. 
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 OpenRoads Designer User Guide – Version 1.0                                                                  Page 46 

7.0 Corridor Modeling 
 

OpenRoads Designer uses the Corridor civil object to model roadway. The 3D model is 

then used to create terrain models, cross sections and generate quantities.  

 

ORD corridors are created directly in the MicroStation views. The corridor information is 

stored in 2D design (dgn) file. The corridor is started in 2D and the 3D model is 

automatically generated and attached to the 2D model. A minimum of one horizontal and 

one vertical civil geometry elements are required to create a corridor.   

 

The corridor modeling toolset includes tools for creating, modifying, managing and 

reporting corridors. These tools can be accessed from the Corridors tab on the 

OpenRoads Modeling workflow ribbon. 

 

 

7.1  Corridor Modeling Workflow 
 

The general workflow for corridor modeling is listed below: 

 

1. Create a 2D design (dgn) file. 

2. Attach existing terrain model as a reference file and set the active terrain. 

3. Attach geometry dgn as a reference (both horizontal and vertical geometry are 

required) 

4. Create a corridor. 

5. Add template drop(s). 

6. Add horizontal and vertical controls to template points (as needed). 

7. Define transitions (as needed) 

8. Assign superelevation (as needed). 

9. Review 3D model and dynamic cross sections 

10. Make adjustments or add additional controls. 

 

7.2  Design Stages 
 

OpenRoads uses corridor feature definitions (also referred to as design stages) to save 

commonly used settings for a corridor. Each corridor can have its own design stage 

within a project and can be changed at any time. 

 

The corridor feature definitions are defined and stored in dgn library 

MTO_Features_Annotations_Levels_ElemTemp.dgnlib under Feature Definitions > 

Corridor.  

 

The design stage is selected when creating a corridor. Once used, the design stage is 

copied into the design file and can be adjusted based on the project need. Set the design 

stage based on the design phase and change it as the design progresses. This will help to 

manage the mount of detail needed to improve the processing speed/performance. 
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The design stage has five sections define a variety of settings and options. They are 

Feature Definitions, Item Type, Processing and Critical Sections, Display Settings and 

Manipulator Settings.  

 

Right-click on a Design Stage and select Properties from the context sensitive menu to 

open the Properties (Element Information) dialog. The settings of the selected design 

stage will be populated. Shown below are the settings for Final stage. 
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Template drop and critical sections settings: 

Feature Definition Name Conceptual Design Final Final w/ Contours 

Template Drop Interval Multiplier 5 2 1 1 

Critical Sections     

Horizontal Cardinal Points Display False True True True 

Vertical Cardinal Points Display False True True True 

External Control Points Display False False True True 

Densify Horizontal False True True True 

Densify Vertical False False False False 

 

 

7.3  Superelevation 
 

In OpenRoads Designer, the superelevation data can be created and stored in its own 2D 

design (dgn) file, or it can be created in the geometry or corridor files. Tools are provided 

for creating, calculating and editing superelevation. 
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To create superelevation, the minimum requirements are one horizontal alignment 

geometry and superelevation rate and transition values calculated using XML-based 

superelevation rule file or imported through a CSV file. 

 

The superelevation rules file has been defined for MTO ORD WorkSpace. It is in the 

following folder: 

 

 ……\Organization-Civil\MTO\Superelevation\ 

 

The rules file is defined based on TAC Geometric Design Guide for Canadian Roads – 

June 2017. As the file name MTO_TAC_06.xml indicated, the max superelevation rate  

e = 6%. Settings for each category are shown below. 

 

General 

 

 
 

Options of creation on this page (above) can be changed at the time of superelevation 

calculation. See below Calculate Superelevation dialog. 
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Tables 

 

 
 

 
 

The table 3.2.6 of Chapter 3 - Alignment and Lane Configuration, TAC Geometric 

Design Guide for Canadian Roads – June 2017 is used to populate the rate and transition 

lookup tables of this superelevation rules file MTO_TAC_06.xml. 

 

Runout and Transition Options 
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Runout Options:  

 

The default option is set to Fixed Length. The tangent runout must be calculated and 

inputted into the rules file for superelevation calculation. According to MTO (TAC) 

standards, the tangent runout length is based on a 1:400 slope.  

 

For example, a roadway has a normal cross slope of 2% and 7m cross section to be 

superelevated, the length of runout will be: 

 

L = 400 * 0.02 (NC) * 7.0 (pavement width) = 56m 

 

When this option is disabled, the runout length is calculated using the same gradient as 

the runoff section. 

 

Transition Options:  

 

By default, the Use Spiral Length option is enabled. If a spiral exists, the spiral length 

will be used as the transition (runoff) length rather than the calculated transition length. 

In this situation, the Percent on Tangent value will be ignored. For curve without spirals, 

60% of the runoff occurs will be on the tangent approach and 40% on the curve. 

 

 
 

Curve Overlap Adjustments 

   

The options on this page define how superelevation stations are adjusted when the exit 

transition from one curve overlaps the entry transition for the next curve.  

 

The Planar option is enabled. With this option the road will transition planer from Full 

Super to Full Super. The Zero Crown and Normal Crown Stations are eliminated.   
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If multiple options (Slide, Shorten, etcetera) are defined for a curve type (reverse curve or 

curve curve) the one with smallest Minimum Transition Gap that is larger than the actual 

gap will be used. 

 

 
 

Custom Key Stations 

   

Custom key stations have been defined to add points where the outside lane is at 1%.  

These points are used for subgrade superelevation. 
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7.4 Subgrade Transition Into Superelevation 
 

The following diagram illustrates the subgrade transition in superelevated sections. 
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8.0 Quantities and Earthwork Volume 
 

OpenRoads Designer provides various tools and methods to compute and report 

quantities and earthwork volume.  

 

 

8.1  Volumes 
 

OpenRoads Designer uses 3D mesh elements to represent the cut and fill volumes 

between the existing terrain model and the bottom mesh of the design elements. The 

earthwork quantities are calculated from the 3D mesh solids using true prismoidal 

method.  

 

The Create Cut and Fill Volumes tool creates a 3D mesh solid for cut and a 3D mesh 

solid for fill. The tool calculates cut and fill volumes between two surfaces. Vertical 

edges are drawn from the Design Surface to the Existing Surface and the volume (in 

master units) is calculated directly from the closed 3D solid. No longer need to create a 

set of cross sections to get the cut and fill volumes. 

 

This tool can be accessed from both the OpenRoads Modeling and OpenRoads Drawing 

Production workflow ribbon. 

 

OpenRoads Modeling > Terrain > Analysis > Volumes 

 

OpenRoads Modeling > Home > Model Analysis and Reporting > Civil Analysis 

 

OpenRoads Drawing Production > Home > Model Analysis and Reporting > Civil 

Analysis 

 

Two feature definitions Volumes_Cut and Volumes_Fill are used for this calculation. 

 

  
 

They are defined under Mesh > Volumes with the Volume Option set to Cut and Fill 

respectively.  
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This tool will create the cut/fill 3D mesh elements to display where the cut and fill are 

located in the model. The blue 3D mesh element indicates fill and the red 3D mesh 

element indicated cut. 
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The volumes of the 3D solids can be viewed in Quick Properties (accessed from the 

context sensitive menu) or Properties dialog. 
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8.2  Quantities and Volumes Report 
 

The Quantities Report By Named Boundary tool allows to report the corridor 

quantities and volumes for the entire corridor model or for specific station ranges and/or 

sheet clipping.  

 

The cut and fill volumes are determined from the 3D mesh solids using the Create Cut 

Fill Volume tool. The other material quantities are computer from the 3D corridor 

models. When a Named Boundary does not exist or no Named Boundary Group is 

selected on the Quantities Report By Named Boundary dialog, the quantities are the total 

quantities from the entire 3D model. 
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The Place Named Boundary tool is used to create custom boundary shape along the 

corridor, quantities can then be calculated within a Named Boundary using the Quantities 

Report by Named Boundary tool. 

 

The sheet definitions have been setup for creating the named boundary and drawings in 

MTO workspace. Select a drawing seed will automatically populate the Place Named 

Boundary dialog with a set of predefined values.   
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8.3  Feature Definition Volume Options 
 

Feature Definitions are used to define various properties of the geometric elements. The 

mesh feature definition has a volume option which controls how earthwork will be 

classified and calculated, as well as the display of the 3D meshes. Options include None, 

Design, Existing, Subgrade, Substrata, Cut, Fill, Unsuitable and Custom. 

 

 
 

To create and calculated the cut and fill volumes, the Existing and Design volume option 

must be defined between any two terrains or corridors. All the feature definitions for 

existing terrain except the Unsuitable Boundary have volume option set to Existing or 

Substrata.  

 

 
 

 

All the feature definitions for proposed terrain and proposed corridor components have 

volume option set to Design. 
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Under Mesh > Existing, feature definitions have volume option set to Substrate or 

Unsuitable. 

 

 
 

 

The Unsuitable material is able to be split into Remove Only and Remove & Replace. 
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8.4  End-Area Volume 
 

The End Area Volumes Report tool is used to extract the traditional end-area volume 

using a series of cross sections defined with the cross section named boundaries along an 

alignment. The terrain model for existing conditions and proposed 3D model are required 

for this volume calculation. You can also add unsuitable material to calculations and/or 

add volume exceptions. The quantities are reported on a station-by-station basis.  

 

Refer to Plan Production section for (cross section) Named Boundary creation. 

 

There are three predefined drawing seeds for placing cross section named boundaries in 

MTO workspace. Depending on the drawings to be produced, select a drawing seed from 

the Drawing Seed drop drown list to place the cross section named boundaries.  

 

 
 

Adjust the left and right offset and the top and bottom clearance to fit the 3D model 

elements inside the named boundaries. 

 

The Cross Section Named Boundaries will be placed in the 3D model. 

 

 
 

Select Home > Model Analysis and Reporting > Civil Analysis > End Area Volumes 

Report 
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Follow the heads-up prompts to select the named boundary group and decide the volume 

exceptions, the Bentley Civil Report Browser will be displayed with calculated volumes. 

By default, the EndAreaVolume.xsl style sheet is used. Select other style sheet from the 

Evaluation folder on the left panel of the browser will present the data in different 

format.  

 

 
 

 

8.5  Unsuitable materials 
 

OpenRoads Designer is able to calculate the unsuitable materials like topsoil and 

pavement removal. When the Volume is set to Unsuitable in the feature definition, the 

material can be quantified as removed only or removed and replaced with fill material. If 

the Split option is set to True, the calculation will differentiate the quantities from what 

is to be removed only and what is to be removed and replaced. 

 

The feature definitions for unsuitable material are located at: 

 

……Mesh\Existing\ 

 

 
 

Some of these feature definitions are set to split. Change the Split option as per the 

project requirements.  
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To calculate the Unsuitable Materials volume, a surface template is to be applied to a 

terrain model representing the top surface of the unsuitable material. Then the terrain 

model can be attached to the file used for volume calculation. 

 

MTO standard template library contains predefined surface templates in the following 

folder: 

 

MTO Library\Surface Templates\ 

 

 
 

Use the surface template to apply a material thickness to the unsuitable material terrain 

model. Change the depth of the template as required.  

 

Shown below existing pavement. 

 

. 
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Once attached the unsuitable material terrain model, use the Create Cut and Fill Volumes 

tool to create 3D cut and fill meshes. When prompt “Use Unsuitable”, select Yes. The 

calculation will take into account the unsuitable material’s volumes. 

 

 
 

Use the Quantities Report By Named Boundary tool to create a report of the quantities 

and volumes for the corridor model. Select Volumes.xsl to change the report type. Shown 

below the existing pavement volume is split into Replaced and Removed (not replaced). 
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8.6  Cut/Fill Factor 
 

To account for any swell or shrinkage that may occur when remove/place material, a 

factor can be applied to the cut or fill volume.  

 

The Volumes_Cut and Volumes_Fill have a setting to define the cut/fill factors.  

 

 
 

 

8.7  Mass Haul Diagram 
 

This command generates a Mass Haul diagram representing the cumulative total of cut 

and fill volumes along a horizontal alignment or defined plan or cross section boundary 

group. Before you generate a Mass-Haul diagram, have the 3D Cut Fill meshes created. 

 

Select Home > Model Analysis and Reporting > Civil Analysis > Mass-Haul 

Diagram 

 

Follow the heads up prompts to select and input values. 

 

When prompt for Annotation Group, press and hold <ALT> Down Arrow and select 

Profile > Drawing > Mass Haul Diagram 
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The accepted values are displayed in the Mass Haul Diagram dialog as shown below. 

 

 
 

The Mass Haul Diagram will be created and opened in a separate Drawing Model.  
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The Mass Haul report is displayed in the Bentley Civil Report Browser.  

 

 
 

The major grid of the annotation group Mass Haul Diagram is set to 100 for the 

Horizontal Interval and 10000 for the Vertical Interval. 
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Each horizontal major grid is 100m and each vertical major grid is 10000 m3. With 

vertical exaggeration of 0.01, each grid is 100 x 100 drawing master unit. 
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9.0 Drawing Production 
 

OpenRoads Designer provides drawing production workflow and tools for automated 

Plan, Profile, and cross section sheet creation.  

 

Named Boundaries are used to define the extent of what is to be displayed on the sheet, 

and to create and manage the sheets. Seed files and sheet seed definitions are created for 

generating the customized sheets. 

 

9.1  Seed Files 
 

The Drawing Seed and Sheet Seed are required to generate customized sheets. Two seed 

files MTO_SheetSeed.dgn and MTO_DrawingSeed.dgn are provided in the following 

folder: 

 

 ……\Organization-Civil\MTO\Seed\Sheets\ 

 

The following 4 variables are set with these seed files for the sheet creation. 

 

MS_DRAWINGMODELSEED 

 

MS_DRAWINGMODELSEEDNAME 

 

MS_SHEETMODELSEED 

 

MS_SHEETMODELSEEDNAME 

 

9.2  Sheet Seed Definitions 
 

The following sheet definitions have been setup for creating the named boundary and 

drawings. Each of this sheet definition has a set of predefined values. Chang settings on 

the Place Named Boundary dialog to meet project specific requirements. 

 

- Civil Plan  

Plan - Full Size 

Plan - Half Size 

Plan-Profile - Full Size (Plan Port) 

Plan-Profile - Half Size (Plan Port) 

 

- Civil Profile 

Profile - Full Size 

Profile - Half Size 

Plan-Profile - Full Size (Profile Port) 

Plan-Profile - Half Size (Profile Port) 

Profile-Profile - Half Size (Top Port) 
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- Civil Cross Section 

Cross Section - Half Size 

Cross Section - Roll Plot 

Cross Section - Stacked 

 

 

9.3  Named Boundaries 
 

Select the Place Named Boundary command from the Drawing Production tab Named 

Boundaries group on the OpenRoads Modeling workflow ribbon, or on the OpenRoads 

Drawing Production workflow ribbon. 

 

Drawing Production > Named Boundaries > Named Boundary 

 

Civil Plan 

 

For plan named boundaries, select Civil Plan mode,  

 

 
 

Select a sheet definition from the Drawing Seed drop drown list. There are four drawing 

seeds (two for plan and profile) are available in the workspace. 
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Some of the settings on the dialog have been set for each of these drawing seed. They can 

be changed for project specific requirements. Some of the fields need to be filled by user. 

 

Civil Profile 

 

For profile named boundaries, select Civil Profile mode,  
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Select a sheet definition from the Drawing Seed drop drown list. There are five drawing 

seeds (two for plan and profile) are available in the workspace. Change the default values 

if desired. 

 

 
 

Civil Cross Section 

 

To place cross section named boundaries, the 3D model must be open and available. 

Select Civil Cross Section mode.  
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Select a sheet definition from the Drawing Seed drop drown list. There are three drawing 

seeds are available in the workspace. Each drawing seed has a set of default values such 

as offsets, intervals, and clearances that can be changed for project specific needs when 

creating the cross section named boundaries. 

 

 
 

Shown below, cross section name boundaries created and displayed in 3D model. 

 

 
 

 

9.4  Sheet Creation 
 

The Create Drawing tool is used to create Drawing models and Sheet models. The tool 

can be activated through the Place Named Boundary dialog once the Named Boundaries 

are created, or from the Named Boundaries manager (dialog) after the Named 

Boundaries have been placed. 

 

One Drawing model is created for each Named Boundary. One or more Drawing models 

is then referenced onto a Sheet model for sheet creation. The drawing model and the 

sheet model will be automatically updated as the model changes. 

 

On the Create Drawing dialog, there are additional settings for both Drawing Model and 

Sheet Model (e.g., Annotation Group, scales, etc.). The default options and values on this 

dialog can be changed if desired when creating the sheets. 
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Plan Create Drawing dialog: 
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Plan Named Boundaries and sheet: 
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Profile Create Drawing dialog: 
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Profile Named Boundaries and sheet: 
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For Plan and Profile sheet, the Create Drawing dialog has settings for both Plan and 

Profile: 
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Cross Section Create Drawing dialog: 
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Cross Sections generated in sheet and roll: 

 

 
 

 

 
 

 

9.5  Drawing Annotation 
 

Annotation Groups are defined for Plan, Profile and Cross Sections annotations. When an 

annotation group is assigned on the Create Drawing dialog, sheets will be created and 

annotated automatically. Annotation can also be added after the sheets are created. For 

project specific requirements, the annotation groups can be modified with additional 

annotation definitions either from other annotation groups or created by users, or use 

multiple annotation groups.  
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Each sheet seed definition in the workspace has an annotation group assigned.  This 

annotation group can be removed or replaced with a different available annotation group 

on the Create Drawing dialog. Annotation groups can also be applied after sheets are 

created. 

  

Shown below are available drawing annotation groups.  
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9.6  Cross Sections Annotation and Report 
 

The cross section annotation can be placed automatically with assigning an annotation 

group when creating cross section sheets or manually placed in the drawing model after 

the cross sections are generated. 

 

9.6.1 Point Annotation 

 

The annotation group XS Grid w/ Annotation can be used to annotate cross section points 

and segments. This annotation group contains annotation definitions to annotate the top 

layer slope and points.  

 

The points listed in the annotation definition XS TP Point Annotation are from a 

template in MTO’s template library. Check the point list and make necessary adjustment 

so all the points to be annotated are included. It may be necessary to recreate the point list 

by selecting points from the project cross section templates.  

 

Expand the Annotation Groups category from the OpenRoads Standards tab on 

Explorer dialog, right click on the annotation group and select Manage to open the 

Manage Annotations dialog. 
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Select the XS TP Point Annotation definition and click on the ellipsis button at the end 

of the location field to open the Annotation Filter dialog. The point list is at the bottom of 

the page. 

 

 
 

 
 

When the Points to be Filtered option on the Annotation Filter dialog is set to Use all 

points, all the points from specified location will be annotated (no list required). 
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Shown below Annotation for top layer with selected points and with all points. 

 

 
 

 
 

The Point Annotation definition can be modified to annotate point from different layers 

(e.g. subgrade) and/or for existing features (e.g.  existing ES, EP etc.).  
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Shown below Annotation for both top and subgrade layers. 

 

 
 

Additional Annotation Definitions can be added to the annotation group from other 

annotation group or user defined annotation group/definition. Shown below annotation 

with point names and existing ground elevation. 
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9.6.2 End Area Volume Annotation 

 

The annotation group XS EAV Annotation can be used to annotate EAV on cross 

sections. 

 

The annotation group can be applied on the Create Drawing dialog when create the cross 

section drawings or using the Annotate Drawing Model tool after the drawings are 

created.  

 

 
 

The default cut/fill annotation is set to be at the top right corner of the cross section.  
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9.6.3 Cross Section Report 

 

The Cross Section Report tool creates a station, offset, and elevation report for a specified 

cross section Named Boundary Group. 

 

The Bentley Civil Report Browser, along with the style sheet are used to view and print 

the reports. Select Evaluation > CrossSectionGradebook.xsl, 

CrossSectionGradebookfromCL.xsl (design surface) or 

CrossSectionGradebookWide.xsl (subsurface). 

 

 

 

 
 

 

 
 

 

9.7  Print/Plot 
 

Two pen table files MTO_monochrome_Full_Size.tbl & 

MTO_monochrome_Half_Size.tbl are provided. They are equivalent to the IESCAD plot 

styles MTO_monochrome_Full_Size.ctb and MTO_monochrome_Half_Size.ctb with 

Construction Class elements excluded from printing.  
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These files are located at: 

 

…\MTO ORD Standards\Organization-Civil\MTO\Pen Tables\ 

 

The printer driver configuration file MTO_PDF.pltcfg provides a “Roll” paper size with 

maximum 5000 x 580mm usable area. 

 

 
 

 

9.8  Export to DWG 
 

DGN file in ORD can be exported to common file types including DWG drawing file. 

 

Select the File tab to open the backstage view then select Export > Common File Types 

> DWG (*.dwg).  

 

This will open the Export File dialog.  
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Click Options button on the bottom of the dialog will open the Save As DWG/DXF 

Options dialog to allow user more precisely to define what and how the DGN file will be 

exported to DWG format. Controls are grouped in tabbed sections. 

 

  
 

 

The General tab contains basic options for saving to DWG/DXF files. The Reference tab 

controls how references are handled when the DGN file is saved to a DWG/DXF file. 

The Filter tab is used to filter the data that is saved to the output file. 

 

The annotation group XS EAV Annotation is used for the cross-section quantity 

annotation and the End Area Volumes are annotated with the XS_EAV_Table cell. To 

export the cross sections with the quantity annotation to DWG, the annotation group 

properties of the XS_EAV_Table cell need to be removed in order for the annotated 

quantities to be properly exported to DWG format.     

 

Select all the XS_EAV_Table cells, then select Drop Element command from the 

Drawing tab Groups on the OpenRoads Modeling workflow ribbon to drop their 

annotation group properties. 

 

On the Drop Element dialog, check the Complex option and follow the prompt to 

Accept. 
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10.0 Deliverables 
 

Electronic Design Data is required for all MTO design projects. The ORD design 

submission shall include ALL files and data used in the preparation of the cross-section 

drawings, quantities, and reports. Project data should be identical to the contents 

presented in the contract book. 

 

These may include but not limited to: 

 

a. Surface file (.tin, .dtm) 

b. 2D & 3D individual design models (terrain, geometry, superelevation, corridors, 

drainage, bridge, etc.) (.dgn) 

c. Master model (contain all terrain, geometry, corridors, superelevation, etc. for 

plan sheets, cross section, quantities, reports) (.dgn) 

d. Exported data from design models (.xml, .imodel, .ifc, .dwg) 

e. ORD project Template file (.itl) 

f. Superelevation rule file (.xml)  

g. Reports (.xml, .xlsx, .docx, .pdf, .txt) 

h. Project drawing sheets (.dwg, .dgn, .pdf)  

i. Supporting, import/export, data exchange files (various format) 

 

A project content/summary file should also be submitted along with the ORD project data 

set. This file contains specific project information, software used in design process and 

their version, special settings and customizations, and descriptions of the files and data 

contained in the submitted project data set. This file is an important reference for MTO 

staff and contractors who may use the information to identify the design files and use the 

project data for construction, quantities, and asset management. 

 

 

 


